November 3, 2003

MANUAL FOR RUNNING SAMPLES ON THE
BECTON-DICKINSON 4-COLOR FLOW
CYTOMETER IN COAS

Prepared by Jennifer Crain with help from Krista Longnecker

FCM facility managed by Barry and Ev Sherr
Protocol

1. Prepare and de-gas sheath fluid 1
2. Prepare the computer and flow cytometer 1
3. Prepare Flow Cytometer 2
4. Set up software for phytoplankton counts 3
5. Check to see if the flow cytometer is running properly 5
6. Thaw SYBR stain 7
7. Thaw a set of samples 7
8. Set up bacterial samples 7
9. Prepare and run phytoplankton samples 8
10. Set up software for bacteria counts 9
11. Run bacteria samples 12
12. Save files, clean cytometer lines, shut down 14

Flow Cytometry Batch Analysis 15

Working with Data file in Excel 21

Appendix I
Collection and Preservation of Samples for Flow Cytometry 22

Appendix II
Solutions, Bead Stocks and Sheath Fluid 23

Appendix III
Bead Calibration 24

Appendix IV
Procedure for purging air bubbles from flow cytometer lines 30

Appendix V
CELLQuest Files 31
IN SITU SEAWATER SAMPLES – PHYTOPLANKTON AND BACTERIA

General protocol for FCM analysis of abundances of Synechococcus, Prochlorococcus, eukaryotic phytoplankton, and bacteria in seawater samples

Sample preservation: See Appendix I
Solutions and bead stocks needed: See Appendix II

Protocol

1. Prepare and de-gas sheath fluid: (to remove bubbles)
   1) Fill carboy with water from Milli-Q system.
   2) Pass the water through a .2 µm inline filter. This is most easily accomplished by putting a clean Nalgene bottle under the spigot, opening the spigot, and pressurizing the carboy by turning on the air nozzle attached to the system (note that you have to have the small cap on the spare outlet on top of the carboy or the larger one will pop off and you can't pressurize the carboy. Be careful not to overpressurize the carboy! Put the larger cap back on after you finish, or the pressurized water will leak from the tap).
   3) Transfer the 0.2 µm filtered DiW and stir bar into large vacuum flask on stir motor.
   4) Put rubber stopper in top and hook up the vacuum hose to the flask.
   5) Turn on the vacuum.
   6) Begin stirring. You should see bubbles come out of solution at first.
   7) Continue stirring with vacuum on for approximately 15 minutes, then turn off stir motor while keeping the vacuum on.
   8) Continue to de-gas using the vacuum for approximately 1 hour.

Note: Since you will need to refill the sheath fluid tank several times during a full day of operation, it is best to keep refilling the vacuum flask and degassing sheath fluid while you are running samples so you don't have to wait for this step before refilling the reservoir.

2. Prepare the computer and flow cytometer (at least 15-20 minutes prior to run):
   1) Turn on the cytometer (green button on the side), before turning on the computer and monitor. Make sure that the cytometer is in standby mode.

   Note: There should be a sample tube with approximately 1 - 2 cm of DiW on the SIP tube. DO NOT OVERFILL THE DiW TUBE!!

   2) Turn on the monitor, then the computer. Login: xxxxxx Password: xxxxxx
   3) Call up CELLQuest 3.3 software by opening the CELLQuest icon from the desktop. An untitled experimental document window will appear on the screen, with control menus at the top.
   4) Connect to Cytometer in the Acquire menu.
5) **The Acquisition Control window will appear on the screen.** Move the window to the right of the experimental document window.

6) **Open the Counters window** in the Acquire menu, move window to the right of the experimental document window.

7) **Open the Status window** in the Cytometer menu, move the window to the right of experimental document window. Status will not be Ready until the machine has warmed up for approximately 5 minutes.

3. Prepare Flow Cytometer:

Check fluidics compartment, system pressure and purge air bubbles:

1) **Depressurize system.** Release pressure by flipping toggle switch to "tank change".

2) **Fill the sheath reservoir tank.** This is the tank on the left. Unscrew cap on reservoir and carefully lay aside on a paper towel. Add sheath water to a level just below the bulge or shoulder in the reservoir. This level should be marked "max fill level". DO NOT OVERFILL! If it is too full, the system will not pressurize properly. Replace cap, being careful not to crimp any of the lines or cross-thread the cap. Be sure the cap is on as tightly as you can get it using only your hands.

3) **Empty waste fluid container.** Unscrew cap on reservoir and carefully lay aside on a paper towel. As long as you have not been running radioactive or other nasty samples, the contents of the waste reservoir can be poured down the sink. Replace cap, being careful not to crimp any of the lines or cross-thread the cap. Tightness is not critical for this cap.

4) **Repressurize system** by flipping toggle switch to "pressurize system".

5) **Clear air from sheath filter and fluid lines:**

   - **Sheath filter and lines:** Tap vigorously on the sheath filter housing, then open the thumb switch on tubing leading from outer housing to allow bubbles to escape. Close the switch. Clear any visible bubbles from the inner housing by disconnecting the tubing from the end away from the housing and pressing the nipple on the end of the tubing to run some fluid out into a beaker. Replace the tubing.

   - **Sheath fluid tank lines:** Clear any visible bubbles from lines by disconnecting the tubing from the end away from the reservoir and pressing the nipple on the end of the tubing to run some fluid out into a beaker. Replace the tubing.

   - **Waste tank lines:** We are not concerned about bubbles in these lines.

6) **Prime the cytometer** to be sure that there are no bubbles in the flow cell. (Do this whenever you start the machine or if you have opened up the fluidics compartment reservoirs. This should also be the first thing you do if you have sporadic results that lead you to think you may have a bubble in the flow cell.) Take the sample tube off of the SIP tube and press the prime button. The machine will return to standby mode when it is finished. Replace the sample tube on the SIP tube. (If the machine has not been primed, you will get a message that the machine is not ready when you try to run it.)

7) **Check that the Sample Voltage in the Status window on computer screen is 10.23** when the machine is on standby. If this value is lower or fluctuating, then the system is not properly pressurized. Is the sheath fluid lid on tight? Does it contain the correct volume? Are bubbles in the line? Has the toggle switch been returned to the pressure setting?
8) **Look for bubbles in the tubing leading to the flow cell.** Lift up the lid of the cytometer. You will see the flow cell compartment to the right of center, behind an amber window. Using the flashlight in the drawer below, check for bubbles in the tubing leading up from the lower compartment (about 10 inches back on the right side of the flow cell area), across the front under the flow cell area, and entering the flow cell compartment. If there are even small bubbles in this tubing, you will need to purge the system. *See Appendix IV for bubble purging procedure.*

4. **Set up software for phytoplankton counts:** *(See Appendix V for CELLQuest file descriptions)*

1) **Close the untitled document** without saving, leaving all other windows open.

2) **Set up acquisition document:**
   1) In **File** menu, choose **Open**.
   2) **Open** most recent phytoplankton experimental document.
   3) **Save** document into folder set up for current set of samples, if you have not already done so.

In the phytoplankton plots, we look at the following parameters:

**FL2-H:** orange fluorescence (564 - 606 nm)
**FL3-H:** long band-pass red fluorescence (> 670 nm)
**SSC-H:** side scatter (light scatter). Influenced by particle size and shape, refractive index and internal cell structure.

In the following configuration:
3) Highlight each plot and check to be sure it is in Acquisition to Analysis mode:
   1) Click on the first plot to select it.
   2) In the Plots menu, choose Format Dot Plot.
   3) Make sure plot source is Acquisition to Analysis.
   4) Continue checking each plot until you have checked them all.

2) Set Instrument Settings:
   1) In Cytometer menu, select Instrument Settings.
   2) In dialog box, click Open, then choose the most recent bacteria list mode file.
   3) Click Open, then click Set.
   4) Wait for the little globe to stop rotating before clicking Done.

The settings should be as follows for phytoplankton counts:

```
Cytometer Type: FACSCalibur

Detectors/Amps:
Param  Detector  Voltage  AmpGain  Mode
P1      FSC       E01      2.00      Log
P2      SSC       396      1.00      Log
P3      FL1       600      1.00      Log
P4      FL2       531      1.00      Log
P5      FL3       600      1.00      Log
P6      FL3-A     1.00      Lin
P7      FL3-W     1.00      Lin

Threshold:
Primary Parameter: FL3
Value: 180

Secondary Parameter: None

Compensation:
FL1 - 0.8 % FL2
FL2 - 20.5 % FL1
FL2 - 0.0 % FL3
FL3 - 13.1 % FL2
```

4) Check Acquisition & Storage settings:
   Choose Acquisition and Storage from the Acquire menu.

   Settings should be as follow:

   Acquisition Gate:
   
   Accept All events

   Collection Criteria:
Event Count or Time
Acquisition will stop when 1000000 of All events are counted
OR after 180 seconds Time Resolution 200 ms

Storage Gate:
Data file will contain: All events

5) Choose a folder and filename for data storage:

1) In Acquire menu, select Parameter Description.

2) When dialog box pops up, click Folder and either choose an existing folder or set up a new folder (or subfolder), then click Choose "name of folder" at the bottom.

3) Click File, type in desired name of Custom Prefix for list mode files and set the File Count to "1" if starting a new set of data or to the next number in sequence if continuing a set of data. Click "OK".

Note: If using Krista's method for naming files to be processed in Matlab, you will need to use the following protocol for naming list mode files:

1) Choose Sample ID for the custom prefix. Enter desired sample ID.

2) Update the suffix to the next number in the series.

Example: Ricardo's lab is using the filename TH0502bxxx.xx for their bacterial samples. (Thompson May 02 cruise, b or p for bacteria or phyto. The first number is the sample ID given in 3 digits, the suffix is the file number in 3 digits.)

3) Click on another CELLQuest window to update the new filename in the Parameter Description box and Acquisition Window

4) Leave the Parameter Description box open to make filename changes for the next sample.

Note: Sometimes this window locks up and will not allow you to enter a new filename. If this happens, close the window and reopen it.

5) The program will automatically increment the file number (suffix).

6) Change filename for each sample before running.

6) Save Acquisition document under a new filename if starting a new set of data.

5. Check to see if the flow cytometer is running properly using 3.0 µm beads in DiW, set up as a phytoplankton document:

1) Take the 3.0 µm bead working stock out of the fridge and make sure you have the tip designated for 3 um beads on the pipetter.

2) Put Cytometer on HI flow rate.

3) Check the Sample Voltage on the Status box on the computer. It should be 10.23 when the cytometer is on Standby.
4) **Note Sample Voltage level from previous runs** on your datasheet. This is the level at which the voltage stabilized when the sample was run. It should be written on each data sheet, and should not vary between runs if the cytometer is working properly and has not been readjusted.

5) **Look at Acquisition window to be sure that the "Setup" box is checked** so you do not save these data (note: if you do want to save these data for some reason, be sure the setup box is not checked and the filename is correct)

6) **Switch cytometer from Standby to Run** while the DiW tube (with 1-2 cm DiW) is still on the SIP tube.

   The cytometer should always be in Run mode before switching between samples, so it is actively sucking sample rather than spitting fluid back into the tube. It is a good idea to have it in Run mode for approximately 30 seconds prior to placing a sample tube on the SIP, to allow time for the initial “spit” of sheath fluid to go into the DiW rather than your sample.

7) **Pipe 500 µl of .2 µm filtered DiW** into a cytometer tube.

8) **Gently swirl and invert the 3.0 µm bead container 4-5 times.** Do not shake or swirl too vigorously or you can cause the beads to clump.

9) **Pipe 25 µl of bead stock** into the tube.

10) **Vortex briefly** on medium speed.

11) **Position the sample tube on the SIP tube.** Make sure it is a tight fit. Do not rotate the tube when installing or removing it from the cytometer, as twisting can loosen the SIP and cause spurious results.

12) **Watch the Sample voltage** in the Status box on the computer. When the voltage stabilizes, check to be sure it is similar to the voltage from the previous run.

13) **Click Acquire in the Acquisition Control window** to begin recording data. Dots should begin appearing in the plot in the Experimental Document and should show patterns similar to the screen shot shown above. If this is the case, everything is okay and you can go ahead and run samples. If not, you need to stop at this point and find out what is wrong before thawing any samples.

   *Keep in mind that there will be a difference in bead counts between beads in DiW and in seawater due to the difference in the refractive index!!! The counts are usually slightly higher in DiW than in FSW.*

14) **The run will not automatically end** since you have checked the Setup box. When approximately 3 minutes, 8 seconds have elapsed, click **Pause**.

15) **Note the bead counts and compare them with expected counts.**

16) **Click Abort.**

17) **Replace sample tube with a cytometer tube containing 1-2 cm DiW** and put cytometer in Standby mode while you prepare samples.
6. Thaw SYBR stain:

Take a microcentrifuge tube of frozen SYBR stain from the deep freeze. Thaw it in the dark, usually in a closed drawer, in air. Do not put it in water, for fear of diluting stain if cap is not on tightly enough. If you need to thaw it more quickly, hold it in your closed fist.

7. Thaw a set of samples:

Do this only if you don't suspect a problem with the machine! The samples will have to be run for phytoplankton data once they are thawed. You can refreeze the samples and run for bacteria later but not for the phytoplankton.

1) Take 6 to 10 samples from the freezer, check to be sure all caps are tight, and thaw in a beaker of room temperature water in the dark. Be careful to keep the water level below the level of the caps.

2) Label thawed samples with numbers for the order in which they will be run. Since the samples are often not in consecutive order in the freezer, it is easier to arrange each thawed set in ascending order and write an order number on each with a Sharpie. Since you will be taking samples out of these for both phyto and bacteria runs and working as quickly as possible, idiotproofing is critical at this stage. You need to be able to relate the phyto and bacteria counts for each sample even though you will collect the data at two separate times.

3) Set up a (paper) data sheet for the samples to be run, with sample information and list mode file (data file) name for each sample. Record the concentration of the beads to be used. This concentration should be on the label for each working stock.

4) Place thawed samples in ice bucket and cover. They can remain in the ice bucket for several hours without changing the counts, as long as they have not been previously thawed and refrozen.

8. Set up bacterial samples:

1) Number a cytometer tube for each sample.

2) Pipette 250 µl of freshly 0.2 µm filtered DiW (sheath DiW) into each tube. Keep the sheath water in a beaker covered w/ parafilm.

3) Pipette 45 µl of 0.2 µm filtered potassium citrate into each tube.

4) Gently invert a sample four times and pipette 250 µl of sample into the appropriate tube

5) Rinse pipette tip between samples with 0.2 µm filtered DiW.

6) Repeat steps 4 and 5 above for each sample until all samples have been done.

7) Pipette 5 µl of SYBR stain into each tube.

8) Vortex briefly on medium speed.

9) Place in dark until ready to run the samples (usually we just put the whole rack in a dark drawer).

10) Store SYBR stain and potassium citrate in dark drawer between sets.
11) Wait at least ten minutes before running. The citrate helps to preserve the stain, but samples should not be allowed to sit more than an hour or so before running.

9. Prepare and run phytoplankton samples:

1) Number a cytometer tube for each sample.

2) Take the 3.0 µm bead working stock out of the fridge and make sure you have the tip designated for 3 um beads on the pipetter.

3) Put Cytometer on HI flow rate.

4) Check the Sample Voltage on the Status box on the computer. It should be 10.23 when the cytometer is on Standby.

5) Note Sample Voltage level from previous runs on your datasheet. This is the level at which the voltage stabilized when the sample was run. It should be written on each data sheet, and should not vary between runs if the cytometer is working properly and has not been readjusted.

6) Look at Acquisition window to be sure that the "Setup" box is not checked and the filename is correct.

7) Switch cytometer from Standby to Run while the DiW tube is still on the SIP tube.

Note: The cytometer should always be in Run mode before switching between samples, so it is actively sucking sample rather than spitting fluid back into the tube. It is a good idea to have it in Run mode for approximately 30 seconds prior to placing a sample tube on the SIP, to allow time for the initial “spit” of sheath fluid to go into the DiW rather than your sample.

8) Invert the sample gently 3-4 times. Pipette 500 µl of the sample into a cytometer tube.

9) Rinse pipette tip with 0.2 µm filtered DiW between samples.

10) Gently swirl and invert the 3.0 µm bead container 4-5 times and pipette 25 µl of bead stock into the tube. Do not shake or swirl too vigorously or you can cause the beads to clump.

11) Vortex briefly on medium speed.

12) Position the sample tube on the SIP tube. Make sure it is a tight fit. Do not rotate the tube when installing or removing it from the cytometer, as twisting can loosen the SIP and cause spurious results.

13) Watch the Sample Voltage in the Status box on the computer. When the voltage stabilizes, check to be sure it is similar to the voltage from the previous run.

14) Click Acquire in the Acquisition Control window to begin recording data. Dots should begin appearing in the plot in the Experimental Document and should show patterns similar to the screen shot shown above.

15) The run will automatically end when the run time set in the Acquisition & Storage window is attained. (This takes about 3 minutes, 8 seconds when set to 180 seconds).

16) The file is automatically saved and the filename is automatically incremented by 1.
17) **Move boxes on plot if necessary.** Sometimes you may need to move the region boxes on the plot to contain all the events of interest, as the fluorescence per cell can change from sample to sample. Do this after the run is finished, NEVER while acquiring. **DO NOT MOVE THE BOX FOR THE BEADS!**

18) **Record the count data** from the upper Region Stats box onto the data sheet. Check the previous run to determine the range of the bead count that you should be seeing.

19) **Repeat steps 8 through 18 for each sample.** Once you get the hang of this, you can work more efficiently by starting to prepare the next phytoplankton sample approximately 2.5 minutes into each run.

   **If you need to repeat a sample, make a new sample tube and pipette new sample and beads.** Do not repeat a previously prepared sample, since the initial “spit” from the cytometer will dilute the sample.

   **If you wish to overwrite a file,** you can do so by simply changing the filename and/or file count in the Parameter Description box. A dialog box will pop up when you press Acquire, and you can choose to overwrite the existing file.

**Note:** The cytometer should be put in **Standby mode** if you need extra time between samples or are taking a break. Be sure to put it back in **Run mode** at least 30 seconds prior to running a sample.

20) **Save and Close the Experimental Document** when finished with a batch of samples.

21) **Switch cytometer from Run to Standby.**

22) **Return the 3.0 µm bead working stock to the fridge and switch the pipette tip to the one used for 1.0 µm beads.**

10. **Set up software for bacteria counts:** *(See Appendix V for CELLQuest file descriptions)*

   1) **Save and close the phytoplankton document** if you have not already done so.

   2) **Set up acquisition document.**

      1) In **File** menu, choose **Open**.

      2) **Open** most recent bacteria experimental document.

      3) **Save** document into folder set up for current set of samples, if you have not already done so.

In the bacteria plots, we look at the following parameters:

   **FL1:** green light (515 - 545 nm). For bacteria.

   **FL2-H:** orange fluorescence (564 - 606 nm).

   **SSC-H:** side scatter (light scatter). Influenced by particle size and shape, refractive index and internal cell structure.
In the following configuration:

3) **Highlight each plot and check to be sure it is in Acquisition to Analysis mode.**
   1) **Click on the first plot to select it.**
   2) In the **Plots** menu, choose **Format Dot Plot**.
   3) Make sure plot source is **Acquisition to Analysis**.
   4) **Continue checking each plot** until you have checked them all.

4) **Set Instrument Settings:**
   5) In **Cytometer** menu, select **Instrument Settings**.
   6) In dialog box, click **Open**, then choose the most recent bacteria list mode file.
   7) Click **Open**, then click **Set**.
   8) **Wait** for the little globe to stop rotating before clicking **Done**.
The settings should be as follows for bacterial counts:

### Cytometer Type: **PACSCalibur**

#### Detectors/Amps:

<table>
<thead>
<tr>
<th>Param</th>
<th>Detector</th>
<th>Voltage</th>
<th>AmpGain</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>FSC</td>
<td>E01</td>
<td>2.00</td>
<td>Log</td>
</tr>
<tr>
<td>P2</td>
<td>SSC</td>
<td>500</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P3</td>
<td>FL1</td>
<td>600</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P4</td>
<td>FL2</td>
<td>600</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P5</td>
<td>FL3</td>
<td>701</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P6</td>
<td>FL1-A</td>
<td></td>
<td>1.00</td>
<td>Lin</td>
</tr>
<tr>
<td>P7</td>
<td>FL1-W</td>
<td></td>
<td>1.00</td>
<td>Lin</td>
</tr>
</tbody>
</table>

#### Threshold:
- **Primary Parameter:** FL1
- **Value:** 300
- **Secondary Parameter:** None

#### Compensation:
- FL1 - 0.8 % FL2
- FL2 - 20.5 % FL1
- FL2 - 0.0 % FL3
- FL3 - 13.1 % FL2

5) **Check Acquisition & Storage settings:**

**Choose Acquisition & Storage** from the Acquire menu.

Settings should be as follows:

**Acquisition Gate:**
- **Accept All events**

**Collection Criteria:**
- **Event Count or Time**
- Acquisition will stop when **1000000** of **All events** are counted
- OR after **180** seconds **Time Resolution 200 ms**

**Storage Gate:**
- Data file will contain: **All events**

**Resolution:**
- **1024 Parameters saved**

*Note: For samples with very low cell densities, you will need to set the program for a longer run time. Try doubling the amount of sample and running the counts for about 15 minutes, stopping and saving the run manually when counts reach approximately 500 cells.*
6) Choose a folder and filename for data storage:
   4) In Acquire menu, select Parameter Description.
   5) When dialog box pops up, click Folder and either choose an existing folder or set up a new folder (or subfolder), then click Choose "name of folder" at the bottom.
   6) Click File, type in desired name of Custom Prefix for list mode files and set the File Count to "1" if starting a new set of data or to the next number in sequence if continuing a set of data. Click "OK".

   Note: If using Krista's method for naming files to be processed in Matlab, you will need to use the following protocol for naming list mode files:

   1) Choose Sample ID for the custom prefix. Enter desired sample ID.
   2) Update the suffix to the next number in the series.

       Example: Ricardo's lab is using the filename TH0502bxxx.xx for their bacterial samples. (Thompson May 02 cruise, b or p for bacteria or phyto. The first number is the sample ID given in 3 digits, the suffix is the file number in 3 digits.)

   3) Click on another CELLQuest window to update the new filename in the Parameter Description box and Acquisition Window.
   4) Leave the Parameter Description box open to make filename changes for the next sample.

       Note: Sometimes this window locks up and will not allow you to enter a new filename. If this happens, close the window and reopen it.

   5) The program will automatically increment the file number (suffix).
   6) Change filename for each sample before running.

   7) Save Acquisition document under a new filename if starting a new set of data.

11. Run bacteria samples:
   1) Take the 1.0 µm bead working stock out of the fridge and make sure you have the tip designated for 1 um beads on the pipette.
   2) Put Cytometer on LO flow rate.
   3) Check the Sample voltage on the Status box on the computer. It should be 10.23 when the cytometer is on Standby.
   4) Note sample voltage level from previous runs on your datasheet. This is the level at which the voltage stabilized when the sample was run. It should be written on each data sheet, and should not vary between runs if the cytometer is working properly and has not been readjusted.
   5) Look at Acquisition window to be sure that the "Set up" box is not clicked on and the filename is correct.
6) **Switch cytometer from Standby to Run** while the DiW tube is still on the SIP tube.

*Note:* The cytometer should always be in Run mode before switching between samples, so it is actively sucking sample rather than spitting fluid back into the tube. It is a good idea to have it in Run mode for approximately 30 seconds prior to placing a sample tube on the SIP, to allow time for the initial “spit” of sheath fluid to go into the DiW rather than your sample.

7) **Take a sample tube from the drawer and place it in rack on counter.**

8) **Gently swirl and invert the 1.0 µm bead container 4-5 times and pipette 25 µl of bead stock** into the tube. Do not shake or swirl too vigorously or you can cause the beads to clump.

9) **Vortex briefly** on medium speed.

10) **Position the sample tube on the SIP tube.** Make sure it is a tight fit. Do not rotate the tube when installing or removing it from the cytometer.

11) **Watch the Sample voltage** in the Status box on the computer. When the voltage stabilizes, check to be sure it is similar to the voltage from the previous run.

12) **Click Acquire in the Acquisition Control window** to begin recording data. Dots should begin appearing in the plot in the Experimental Document and should show patterns similar to the screen shot shown above.

13) **The run will automatically end** when the run time set in the Acquisition & Storage window is attained. (This takes about 3 minutes, 8 seconds when set for 180 seconds).

14) **The file is automatically saved and the filename is automatically incremented by 1.**

15) **Move boxes on plot if necessary.** Sometimes you may need to move the region boxes on the plot to contain all the events of interest, as the fluorescence per cell can change from sample to sample. Do this after the run is finished, NEVER while acquiring. **DO NOT MOVE THE BOX FOR THE BEADS!**

16) **Record the count data** from the upper Region Stats box onto the data sheet. Check the previous run to determine the range of the bead count that you should be seeing.

17) **Repeat steps 7 through 17 for each sample.** Once you get the hang of this, you can work more efficiently by starting to prepare the next bacteria sample approximately 2.5 minutes into each run.

   **If you need to repeat a sample, make a new sample tube and pipette new sample and beads.** Do not repeat a previously prepared sample, since the initial “spit” from the cytometer will dilute the sample.

   **If you wish to overwrite a file,** you can do so by simply changing the filename and/or file count in the Parameter Description box. A dialog box will pop up when you press Acquire, and you can choose to overwrite the existing file.

*Note:* The cytometer should be put in Standby mode if you need extra time between samples or are taking a break. Be sure to put it back in Run mode at least 30 seconds prior to running a sample.

18) **Save and close the Experimental Document** when finished with a batch of samples.

19) **Switch cytometer from Run to Standby.**
20) Return the 1.0 µm bead working stock to the fridge and switch the pipette tip to the one used for 3.0 µm beads

12. Save files, clean cytometer lines, shut down:
   
   1) Refreeze the SYBR in the –60 C chest freezer.
   
   2) Return the potassium citrate to the refrigerator.
   
   3) Back up files. See Appendix V for details about backing up files
   
   4) Clean the SIP sample line with 5% chlorox and rinse with DiW.
      This procedure cleans the sample injection tube and the area between the injection tube and the outer sleeve.
      
      a. Fill a cytometer tube with ~3 mls of 5% household bleach in sheath DiW. (There is usually a container of this already made up. It lives on the counter next to the cytometer.) Be careful to not get the top of the SIP tube wet and damage the filter!
      
      b. Run 1-2 ml of 5% bleach solution through the system, being careful to make sure that the tube doesn't go dry. To do this most efficiently, put cytometer in standby mode, put the tube of bleach solution on the SIP, and leave the arm to the right. Keep the arm to the right until you have sucked out 1-2 ml of solution.
      
      c. Move the arm to its normal position under the tube.
      
      d. Run on HI for about 5 minutes, being careful not to suck the tube dry.
      
      e. Rinse the outside of the SIP tube with DiW by immersing it in a tube of DiW. Run the tube up and down the SIP.
      
      f. Dump the tube and pipette approximately 1 ml of .2 µm filtered DiW into a new tube.
      
      g. Run 1-2 ml of DiW through the system, being careful to make sure that the tube doesn't go dry. To do this most efficiently, put cytometer in standby mode, put the tube of bleach solution on the SIP, and leave the arm to the right. Keep the arm to the right until you have sucked out 1-2 ml of solution.
      
      h. Move the arm to its normal position under the tube.
      
      i. Run on HI for about 5 minutes, being careful not to suck the tube dry.
      
5) Put the cytometer in STANDBY mode and wait for at least 5 min to let the laser cool down.

6) Be sure the tube of DiW on the SIP has about 1-2 cm of DiW, not more, not less.

7) Turn off the computer then the monitor.

8) Turn off the cytometer (green button on side).
Flow Cytometry Batch Analysis

Data from list mode files is analyzed in CELLQuest. This generates a text file with all the count data in it. The text file is then imported into Excel or Matlab for editing and calculations.

Batch analysis procedure for phytoplankton:

1. **Open CELLQuest 3.3 from icon on desktop.**

2. **Create a new analysis document:**
   
   1) In **File** menu, choose **Open**. Open the most recent phytoplankton analysis document. This will allow you to use the previously set up contour plots, regions and gates for analyzing your counts.
   
   2) **Save** it with a new name for the current batch analysis. Save it in the appropriate folder for this set of counts.

3. **Open first list mode file in set to analyze:**
   
   1) In **Edit** menu, choose **Select All**.
   
   2) In **Plots** menu, choose **Change Data File**.
   
   3) When file list comes up, **choose the first file in the set** to be analyzed or the next file to be analyzed if you are continuing an ongoing set.
   
   4) **Make sure all plots have been changed to this file.**

4. **Check that each plot is in analysis mode:**
   
   9) **Click on the first plot to select it.**
   
   10) In the **Plots** menu, choose **Format Dot Plot**.
   
   11) Make sure plot source is **Analysis**.
   
   12) **Continue checking each plot** until you have checked them all.

5. **Check that each region stats box is set up properly:**

   1) **Click on the first region stats box to select it.**

   2) In the **Stats** menu, choose **Edit Region Stats**.

   3) **Be sure the following are checked:**

   **Header Info:**
   - Title Line
   - File Name
   - Acquisition Date
   - Total Events
Parameters

Statistics:
- Region Label
- Event Count
- X Mean
- Y Mean

Header Columns:
- 2 columns

4) **Continue checking each region stats box** until you have checked them all.

6. **Set up batch analysis:**

1) In the **Edit menu**, choose **Select All**.

2) In the **Plot menu**, choose **Change Data File** - start with first file in set or where you left off if appending.

3) In the **Batch menu**, choose **Setup**

4) **Make the following choices:**
   - Plots: Stats to Process: All
   - Pause after each file increment: until manual resume
   - Export Statistics: New File  (unless appending, then select file to append)

   **Note:** *This new file cannot have the same name as an existing file or it will overwrite it without asking you!!*

   - File Increment: 1

7. **Run Batch Analysis:**

1) In the **Batch menu**, choose **Run** - Toolbox will come up. It has a button with a square on it to stop, and another button with an arrow on it to move forward through the list mode files consecutively.

2) **For each file, move the boxes to encompass the cells of interest.**

   **Note:** *Do not move the bead boxes!!*
Boxes should look something like the following example:

3) **Go through all files consecutively.** Press the forward arrow on the toolbar to advance to the next list mode file.

*Note: If for some reason you make a mistake and have to repeat an analysis of a list file, keep good notes so you can edit properly in Excel or Matlab later.*


9. Transfer to another computer and import into Excel or Matlab for editing and calculations

**Batch analysis procedure for bacteria:**

1. **Open CELLQuest 3.3.**

2. **Create a new analysis document:**

   1) In **File** menu, choose **Open**. Open the most recent bacteria analysis document. This will allow you to use the previously set up contour plots, regions and gates for analyzing your counts.
2) Save it with a new name for the current batch analysis. Save it in the appropriate folder for this set of counts.

3. Open first list mode file in set to analyze:
   5) In Edit menu, choose Select All.
   6) In Plots menu, choose Change Data File.
   7) When file list comes up, choose the first file in the set to be analyzed or the next file to be analyzed if you are continuing an ongoing set.
   8) Make sure all plots have been changed to this file.

4. Check that each plot is in analysis mode:
   1) Click on the first plot to select it.
   2) In the Plot menu, choose Format Dot Plot.
   3) Make sure plot source is Analysis.
   4) Continue checking each plot until you have checked them all.

5. Check that region stats box is set up properly:
   1) Click on the region stats box next to upper plot to select it.
   2) In the Stats menu, choose Edit Region Stats.
   3) Be sure the following are checked:
      
      Header Info:
      - Title Line
      - File Name
      - Acquisition Date
      - Total Events
      - Parameters
      
      Statistics:
      - Region Label
      - Event Count
      - X Mean
      - Y Mean

      Header Columns:
      - 2 columns

6. Check that gate stats box is set up properly:
   1) Click on the gate stats box next to lower plot to select it.
2) In the **Stats** menu, choose **Edit Gate Stats**.

3) **Be sure the following are checked:**

   **Header Info:**
   - Title Line
   - File Name
   - Acquisition Date
   - Total Events
   - Parameters

   **Statistics:**
   - Gate Label
   - Event Count

   **Header Columns:**
   - 2 columns

**7. Set up Batch Analysis:**

1) In the **Edit** menu, choose **Select All**.

2) In the **Plot** menu, choose **Change Data File** - start with first file in set or where you left off if appending.

3) In the **Batch** menu, choose **Setup**.

4) **Make the following choices:**
   - Plots: Stats to Process: All
   - Pause after each file increment: until manual resume
   - Export Statistics: New File (unless appending, then select file to append)

   *Note: This new file cannot have the same name as an existing file or it will overwrite it without asking you!!*

   - File Increment: 1

**8. Run Batch Analysis:**

1) In the **Batch** menu, choose **Run** - Toolbox will come up. It has a button with a square on it to stop, and another button with an arrow on it to move forward through the list mode files consecutively.

2) **For each file, move the boxes to encompass the cells of interest.** A box can be rotated by highlighting it, going to Gates menu and choosing rotate box.

   *Note: Do not move the bead boxes!!*
3) Go through all files consecutively. Press the forward arrow on the toolbar to advance to the next list mode file.

Note: If for some reason you make a mistake and have to repeat an analysis of a list file, keep good notes so you can edit properly in Excel or Matlab later.


10. Transfer to another computer and import into Excel or Matlab for editing and calculations.
Working with Data file in Excel

1) Import data file into Excel:
   1) Open Excel.
   2) Open data file created when doing batch analysis.
      (Import filter should work on default settings for delimited file)
   3) Save as Excel file.

2) Reduce rows by copying data into new columns:
   1) Copy event counts and the X and Y means from each parameter (SSC, FL2, FL3) into separate columns on the first row of data for each sample.
      (This will create a much wider spreadsheet)
   2) Delete rows from which information has been copied, so that you have only one row per sample.

3) Insert a column for ul sampled.

4) Calculate ul run for each sample as follows:

\[
\text{µl run} = \frac{\text{# beads counted}}{\text{beads/µl in sample tube (written on bead working stock)}}
\]

5) Insert a column for cells/ml for each region of interest.

6) Calculate cells/ml as follows:

\[
\text{cells/ml} = \frac{\text{# cells counted}}{\frac{\text{ul run (calculated above)}}{1000\µl}} \times \frac{\text{Total ul in tube}}{\text{ul SW sample in tube}} \times 1 \text{ ml}
\]

7) Integrate with sample info. (collection location, depth, etc.) from cruise logs and sample lists.

Note that for each region of interest, the X means and Y means for FL2 and FL3 are the mean fluorescences, and SSC is the mean side scatter, used as an indication of mean cell size.
Appendix I

COLLECTION AND PRESERVATION OF SAMPLES FOR FLOW CYTOMETRY

Equipment:
- plastic graduated cylinders, beakers, funnels
- pipette for measuring 3 ml samples

Supplies:
- 1-liter plastic bottles for sample collection from Niskins or experimental bottles
- 4-5 ml cryovials for storing samples in
- marking pens
- Kimwipes
- data sheets (to log in samples: sample number, date, depth, volume sampled)

Chemicals:

Paraformaldehyde solution prepared as follows:

**DO THIS IN A HOOD!!**

1) **Boil 18 ml of deionized water** in a beaker (a microwave would be good for this step).
2) **Weigh out 2 g paraformaldehyde** powder into a clean 125 ml glass flask.
3) **Add the 18 ml of boiling water to the flask containing paraformaldehyde** powder, add a stir bar, place on stir motor, and stir to dissolve.
4) **Add 1 N NaOH solution** drop-wise (about 150 µl in three 50 µl drops) and continue stirring until the precipitate dissolves (should take only a few drops, but will take some time, 0.5 to 1 hr).
5) **Cap flask with parafilm and cool** the solution to room temperature (the flask should be cool already).
6) **Add 2 ml of 0.2 µm filtered seawater**, stir.
7) **Filter 10 ml aliquots** of paraformaldehyde solution through a 0.2 µm acrodisc into two clean glass 20 ml scintillation vials (use 2 acrodiscs, one for each 10 ml aliquot), label and cap tightly, store in fridge.

**NOTE:** Use within a week. This is enough paraformaldehyde to fix > 300, 3-ml samples.

Protocol:

1) **Pipette one 3 ml sample** from the 1 liter bottle sample into a pre-labeled 4 ml cryovial.
2) **Add 60 µl of paraformaldehyde stock**, invert several times.
3) **Let sit** in dark 10 min.
4) **Put in liquid nitrogen. Note: If no LNO2 is available, put into -80C freezer.**
5) **Store until returning to OSU.**
6) **Once back at OSU, store cryovials in box in -80C freezer.**
Appendix II
Solutions, Bead Stocks and Sheath Fluid

Solutions:

- **SYBR Green I working solution:** Buy SYBR Green (SYBR Green 1 nucleic acid gel stain, 10,000 concentrate in DMSO, Molecular Probes Catalog # S-7585) in 10 x 50 µl vials. Store in –60 C freezer. Dilute one 50 µl aliquot to 5 ml with 0.1 um filtered DiW to make 1:100 working stock. Refilter the diluted stain through a 0.2 or 0.1 µm pore size Acrodisc filter. Store frozen in 500 µl aliquots in small vials, thaw one vial when ready to do runs, refreeze when done. At 5 µl per sample, one vial is enough for 100 samples. Final concentration in sample is 1/10,000 of commercial stock.

- **300 mM potassium citrate:** (FW 324.4 g) Dissolve 4.87 g in 50 ml DiW and store in fridge. Filter a 2 ml aliquot through a 0.2 µm Acrodisc at the beginning of each week. At 45 µl per sample, 2 mls is enough for 44 samples. Acrodiscs can be found on counter under the hood, the syringe is stored in the drawer and can be rinsed and reused.

Bead stocks:

- **1.0 µm calibrated bead stock (working stock):**
  1.0 µm diameter fluorescent microspheres (See Appendix III for preparation and calibration of bead stocks). Should be approximately 1 - 2 x 10^6 beads per ml. Stored in refrigerator door. Concentration should be written on side of the bottle.

- **3.0 µm calibrated bead stock (working stock):**
  3.0 µm diameter fluorescent microspheres (See Appendix III for preparation and calibration of bead stocks). Should be approximately 2 - 3 x 10^5 beads per ml. Stored in refrigerator door. Concentration should be written on side of the bottle.

0.2 µm filtered DiW, referred to as sheath water.

1) Fill carboy with water from Milli-Q system.

2) Pass the water through a .2 µm inline filter. This is most easily accomplished by putting a clean Nalgene bottle under the spigot, opening the spigot, and pressurizing the carboy by turning on the air nozzle attached to the system (note that you have to have the small cap on the spare outlet on top of the carboy or the larger one will pop off and you can't pressurize the carboy. Be careful not to overpressurize the carboy! Put the larger cap back on after you finish, or the pressurized water will leak from the tap).

3) Transfer .2 µm filtered DiW and stir bar into large vacuum flask on stir motor.

4) Put rubber stopper in top and hook up the vacuum hose

5) Turn on the vacuum.

6) Begin stirring. You should see bubbles come out of solution at first.

7) Continue stirring with vacuum on for approximately 15 minutes, then turn off stir motor while keeping the vacuum on.

8) Continue to degas using the vacuum for approximately 1 hour.
Appendix III

Bead Calibration

We use TruCount beads and fluorescent microspheres to determine sample volume run through the flow cytometer in order to calculate cell abundances.

TruCount beads (TruCount Control beads, BD Biosciences Catalog # 340335) are 6 µm green-fluorescent microspheres at a known concentration. They need to be stored at –2 to –8 C, and are good for one year (expiration date on box).

There are 3 concentrations of TruCount beads: LO, MED, and HI. It’s best to use the most highly concentrated bead stock (HI = approximately 1006 TC beads per µl, = a concentration of 1,006,000 TC beads per ml). Check the box lid for actual concentrations of TruCount beads, as they vary slightly between lots. Record lot # and concentration of beads used on bead calibration data sheet.

1.0 µm beads (Fluoresbrite calibration grade 1.0 micron YG microspheres (2.66% solids – latex), Polysciences catalog # 18860) and 3.0 µm beads (Fluoresbrite plain 3.0 micron YG microspheres (2.63% solids – latex), Polysciences catalog # 17155) are fluorescent microspheres (FM) which we add to each sample we run to determine the volume sampled. The FM’s are purchased in a concentrated solution, and are diluted in two steps to establish a working bead stock at a concentration of approximately 1 - 2 x 10^6 FM per ml for the 1 um beads and approximately 2-3 x 10^5 FM per ml for the 3 um beads.

A) Concentrated stock of microspheres: this will need to be made up less often, these are stored in the fridge door in labeled 50 ml tissue culture flasks.

1.0 µm and 3.0 µm FM:

1) Empty old concentrated stocks down the drain and clean the containers. Rinse very thoroughly.

2) Measure 10 ml of 0.2 µm filtered DiW (prepared as for the flow cytometer sheath fluid) into each clean container.

3) Add 500 ul 100% EtOH (5% final concentration) to each.

4) Add 1 drop of the 1.0 or 3.0 um beads (in the small plastic bottles stored in the clear plastic boxes) to each container.

5) Mix by shaking gently.

6) Label each container as concentrated stock, including the bead size, and date concentrated stock was made.

7) Store in fridge.

B) Working stock of microspheres: new working stocks of 1.0 and 3.0 µm microspheres should be made up every couple of months, or just before starting a major run of samples.

1.0 µm FM: this working stock should be ~ 1 - 2 x 10^6 FM per ml.

1) Empty old working stock down the drain and clean the container. Rinse very thoroughly.

2) Measure 25 ml of 0.2 µm filtered DiW (prepared as for the flow cytometer sheath fluid) into the clean container.
3) Add 1.25 ml 100% EtOH (5% final concentration).
4) Add 250 µl of the 1 um bead concentrated stock.
5) Mix by shaking gently.
6) Label the container as working stock, including the bead size, and date working stock was made. After calibrating beads, add concentration in working stock and sample to this label.
7) Record bead source, date received, and dates concentrated and working stocks were made on calibration data sheet.
8) Store in refrigerator door.

3.0 µm FM: this working stock should be ~ 2 - 3 x 10^5 FM per ml.

1) Empty old working stock down the drain and clean the container. Rinse very thoroughly.
2) Measure 19 ml of 0.2 µm filtered DiW (prepared as for the flow cytometer sheath fluid) into the clean container.
3) Add 1ml 100% EtOH (5% final concentration).
4) Add 1.5 ml of the 3 um bead concentrated stock.
5) Mix by shaking gently.
6) Label the container as working stock, including the bead size, and date working stock was made. After calibrating beads, add concentration in working stock and sample to this label.
7) Record bead source, date received, and dates concentrated and working stocks were made on calibration data sheet.
8) Store in refrigerator door.

Calibrate the 1.0 µm FM beads with the TC beads:

- Pipette 485 µl of 0.2 µm filtered DiW into a cytometer tube.
- Pipette 485 µl of 0.2 µm filtered SW into the tube.
- Pipette 5 µl of well dispersed TrueCount beads into the tube (usually the high concentration, approximately 5,030 TC beads).
- Pipette 25 µl of 1.0 µm working stock FM into the tube, vortex to mix well.

*Note: The final volume is 1 ml, with a known concentration of TC beads per ml and an unknown concentration 1.0 µm FM per ml.*
1) **Call up the previously established bead calibration experimental document.** ("bead test" folder in data files). There should be 3 boxes labeled 0.6 μm true count beads, 3.0 μm beads, and 1.0 μm beads.

*Note: set FCM Instrument Settings using previous bead calibration list mode file. They should be as follows:*

<table>
<thead>
<tr>
<th>Detector/Amps:</th>
<th></th>
</tr>
</thead>
</table>
| Detector Voltage |  }
| AmpGain | Mode |  }
| F1 | FSC | 801 | 2.00 | Log |
| F2 | SSC | 366 | 1.00 | Log |
| F3 | FL1 | 400 | 1.00 | Log |
| F4 | FL2 | 400 | 1.00 | Log |
| F5 | FL3 | 650 | 1.00 | Log |
| F6 | FL2-A | 1.00 | Lin |
| F7 | FL2-W | 1.00 | Lin |

*Threshold:*
*Primary Parameter:* FL1
*Value:* 400

*Secondary Parameter:* None

*Compensation:*
- FL1 - 0.8% FL2
- FL2 - 20.5% FL1
- FL2 - 0.0% FL3
- FL3 - 13.1% FL2

2) **Run the bead test sample on the cytometer at HI flow** in data acquisition mode for ~ 5 minutes, to obtain counts for the TC and 1.0 μm beads in each region. It is best to try to get approximately the same numbers of beads shown here:
3) **Using the calculations below, calculate the volume of sample**, then use the volume sampled to calculate the concentration of 1.0 µm bead working stock solutions.

4) **Repeat at least three times** to get mean concentration of bead working stock solution.

**Calibrate the 3.0 µm FM with the TC beads:**

- Pipette 970 µl of 0.2 µm filtered SW into a cytometer tube.
- Pipette 5 µl of well dispersed TrueCount beads into the tube (usually the high concentration, approximately 5,030 TC beads).
- Pipette 25 µl of 3.0 µm working stock FM into the tube, vortex to mix well.

*Note: The final volume is 1 ml, with a known concentration of TC beads per ml and an unknown concentration 3.0 µm FM per ml.*

1) Call up the previously established bead calibration experimental document. ("bead test" folder in data files). There should be 3 boxes labeled 0.6 µm true count beads, 3.0 µm beads, and 1.0 µm beads.

*Note: set FCM Instrument Settings using previous bead calibration list mode file. They should be as follows:*

---

**Cytometer Type: FACSCalibur**

<table>
<thead>
<tr>
<th>Param</th>
<th>Detector</th>
<th>Voltage</th>
<th>AmpGain</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>FSC</td>
<td>E01</td>
<td>2.00</td>
<td>Log</td>
</tr>
<tr>
<td>P2</td>
<td>SSC</td>
<td>366</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P3</td>
<td>FL1</td>
<td>400</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P4</td>
<td>FL2</td>
<td>400</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P5</td>
<td>FL3</td>
<td>650</td>
<td>1.00</td>
<td>Log</td>
</tr>
<tr>
<td>P6</td>
<td>FL2-A</td>
<td>1.00</td>
<td></td>
<td>Lin</td>
</tr>
<tr>
<td>P7</td>
<td>FL2-W</td>
<td>1.00</td>
<td></td>
<td>Lin</td>
</tr>
</tbody>
</table>

**Threshold:**

**Primary Parameter:** FL1

**Value:** 400

**Secondary Parameter:** None

**Compensation:**

- FL1 - 0.8 % FL2
- FL2 - 20.5 % FL1
- FL2 - 0.0 % FL3
- FL3 - 13.1 % FL2
2) Run the bead test sample on the cytometer at HI flow in data acquisition mode for ~ 5 minutes, to obtain counts for the TC and 3.0 µm beads in each region. It is best to try to get approximately the same numbers of beads shown here:

3) Using the calculations below, calculate the volume of sample, then use the volume sampled to calculate the concentration of .0 µm bead working stock solutions.

4) Repeat at least three times to get mean concentration of bead working stock solution.

**Calculations:**

**Volume sampled:**

\[
\text{µl sampled} = \frac{\# \text{ TC beads counted}}{1000 \text{µl}} \times \text{beads/ml TC beads in sample (usually 5,030)} \times 1 \text{ ml}
\]

**Concentration of 1.0 or 3.0 µm bead working stock solution:**

\[
\text{beads/ml} = \frac{\#1.0 \text{ or } 3.0 \mu m \text{ beads counted}}{\mu l \text{ bead stock} \times 1000 \mu l} \times \frac{\text{volume sampled (calculated above)}}{\mu l \text{ sample} \times 1 \text{ ml}}
\]
Using the working stock of beads:

- Add a known number of 1.0 or 3.0 µm beads to a known volume of each sample (we use 25 µl of beads per ml of sample), so the number of beads added will be:

\[
\begin{align*}
\text{beads/µl sample} &= \text{beads/ml working stock} \times \left(\frac{\mu l \text{ bead stock}}{\mu l \text{ sample}} \times \frac{1 \text{ ml}}{1000 \text{ ml}}\right) \\
\end{align*}
\]

- Determine the concentration (beads/µl) of beads in the samples you are running for each batch of working stock you make up.

- The bead abundance number will be a constant factor in your sample series, and will be used for each sample to determine the µl of volume processed and thus to determine the abundances of phytoplankton and of bacteria in the samples. Calculate µl sampled as above, substituting 1.0 or 3.0 µm beads for TC beads.

*NOTE:* it is very important to keep a close watch on the number of beads counted by the flow cytometer in each 3 minute sample run. The 3.0 µm bead counts for the phytoplankton samples should be on the order of 2000 – 3000 per three minutes, and for the 1.0 µm beads, about 1500 – 2500 for the bacteria. We ordinarily record the bead count for each sample on the log sheets and keep track of flow rates calculated based on bead counts throughout the run. This enables us to quickly notice if the bead counts vary too much or change drastically.

*If the bead counts are much lower than this, or drop over time during a sample run, something may be wrong with the flow cytometer.*
Appendix IV

Procedure for purging air bubbles from flow cytometer lines

From Tony at Becton Dickinson.

Explanation: if air bubbles get into the lines, they may lodge in high points or corners for a long time and only work their way out slowly if at all. Once an air bubble gets to the flow cell, it may cause the sample stream to shift in order to go around it. This causes a variation in the distance between the sample and the laser and photomultiplier tube.

Symptoms include lowered counts in regions of interest, a shift in fluorescence per event, or other noise in the data. The symptoms may show up only sporadically as small bubbles make their way through.

Procedure:

1) Open CELLQuest, connect to cytometer (under Acquire menu), and bring up Status window (under Cytometer menu) so you can watch sample voltage.

2) Open top of cytometer by lifting and tilting backward.

3) Look for air bubbles in tubing leading to the flow cell. The flow cell is directly behind the amber window, and fluid in the line runs up from the right side of the cytometer into the flow cell on the left. Even small air bubbles can be a problem. Sometimes, especially if you have recently primed the machine, air bubbles will not be visible but you should do this procedure anyway and see if you get some bubbles working their way out. Use a flashlight from the drawer if needed.

4) Put a sample tube with a couple mls DiW on the SIP tube.

5) Check to be sure sheath tank is filled to the shoulder.


7) Immediately press Standby.

8) Depressurize sheath tank by flipping toggle switch to Tank Change position.

9) Loosen cap on sheath fluid.

10) Press Prime.

11) Immediately press Run.

12) Pause 3-5 seconds, then repeat the Prime-Run-Pause steps until meniscus moves from the flow cell (left) along the tubing to a point directly above the SIP tube. Don't let it go much farther than this, or you risk putting air into the tubing below.

13) Press Standby to stop meniscus movement.

14) Tighten cap on sheath fluid tank.

15) Repressurize system by flipping toggle switch to Pressurize.

16) Watch computer screen until sample voltage comes up to 10.23.

17) Press Run on High flow rate.

18) Watch for bubbles to come through tubing. Hopefully, the bubbles will join up with the meniscus and sweep through the flow cell.

19) Repeat Steps 1 through 13 until you are certain there are no more bubbles.
Appendix V
CELLQuest Files

We usually create a separate folder for each data set, and separate folders for phytoplankton and bacteria files within the data set as follows:

| GLOBEC Dec02 |
|--------------|----------------|
| 2 items, 69.01 GB available |
| ![Dec02phyto] | ![Dec02bact] |

**Within the phytoplankton folder, we have:**

1) **An Acquisition file**, also referred to as an experimental document. This document contains the settings and region lists used in acquiring data.
   
   In this example, it is called **Dec02phyto**. An acquisition document should always have the icon associated with this file in the example below.

2) **List mode files**. These are separate files for each sample run, and contain the count data acquired.
   
   In this example, the list mode files are **Dec02syn.001 through Dec02syn.005**. All list mode files should have the icon associated with these files in the example below.

3) **An Analysis file**. This document contains the settings and regions used to analyze the list mode files. The regions are often slightly different from the regions in the acquisition document.
   
   In this example, it is called **Dec02phytoanal**. An analysis document should always have the icon associated with this file in the example below.

4) **A Data file**. This file is created when you analyze the list mode files, and contains the extracted data.
   
   In this example, it is called **Dec02phytodata**. A data file should always have the icon associated with this file in the example below.
Within the bacteria folder, we have:

1) **An Acquisition file**, also referred to as an experimental document. This document contains the settings and region lists used in acquiring data.

In this example, it is called **Dec02bact**. An acquisition document should always have the icon associated with this file in the example below.

2) **List mode files**. These are separate files for each sample run, and contain the count data acquired.

In this example, the list mode files are **Dec02bact.001 through Dec02bact.005**. All list mode files should have the icon associated with these files in the example below.

3) **An Analysis file**. This document contains the settings and regions used to analyze the list mode files. The regions are often slightly different from the regions in the acquisition document.

In this example, it is called **Dec02bactanal**. An analysis document should always have the icon associated with this file in the example below.

4) **A Data file**. This file is created when you analyze the list mode files, and contains the extracted data.

In this example, it is called **Dec02bactdata**. A data file should always have the icon associated with this file in the example below.
Backing up files:

*At the end of each day*, we back up the files onto Terrafirma Scratch (or another server).

*At the end of a set of data*, we back up onto a CD using the other Mac in the lab.

*Note: When backing up files, be absolutely sure the icons are correct before deleting original files from the hard drive!!*

*If the icons are not correct, CELLQuest will not be able to read the files.*

*When backing up onto CD, it is usually best to make the CD, then open the files from it using CELLQuest to be certain they are readable.*